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1. Software Download and Installation

If the Quartus software will be run locally or a remote (cloud server), the steps to
download and install the software will be different.

If the software will be used on a local computer, refer to the Section called Local
Software download and install.

If the software will be run remotely, refer to the Section called Remote Software and
install.

For a local install, the files are large, so the internet speed needs to be fast.

2. Local Software download and install

When running on a local computer, there will be 2 software packages to be installed.

The first one will be Quartus 25.1 software package. Within the Quartus 25.1
software package, Quartus, RiscFree (for the Nios V software) and Questa-Sim Intel
FPGA Starter (for simulation) will all be installed.

The Power Thermal Calculator (stand-alone) version will also need to be
downloaded and installed.

These steps are for Windows based install, because the workshops were run on
Windows computers.

2.1 Software download
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2.1.1 Quartus Prime Pro download

Go to the Quartus Prime Pro 25.1 at

https://www.intel.com/content/www/us/en/software-kit/851653/intel-quartus-prime-pro-
edition-desigh-software-version-25-1-for-windows.html

Which looks like:

Intel® Quartus® Prime Pro Edition Design Software Version 251 for Windows

Date Software Type Software Package Version Operating Systems

The Intel* Quartus® Prime Pro Edition Design Software, Version 25.1 includes functional and security updates. Users should keep their software up-to-date and follow the technical recommendations to help improve
security. Additional security updates are planned and will be provided as they become available. Users should promptly install the latest version upon release.

Intel® Quartus® Prime Pro Edition Design Software, Version 25.1 is subject to removal from the web when support for all devices in this release are available in a newer version, or all devices supported by this version are
obsolete. If you would like to receive customer notifications by e-mail, please subscribe to our subscribe to our customer notification mailing list.

If you are using floating license server for Intel FPGA software, you need to upgrade to the latest license daemon software (v11.19.6.0). Intel FPGA software, version Pro, doesn’t work with old version of daemon software.
You can download the daemon software from this link

To find software versions that support specific device families:
- Refer to the Device Support List
« Use the Software Selector

Critical Issues and Patches for the Intel® Quartus® Prime Pro Edition Software, Version 25.1.
Knowledge Base: Search for Errata.
Problems and Answers on specific IP or Products.

Downloads

Installer (Recommended) Individual Files Copyleft Licensed Source

Quartus Prime Pro (unlike the Quartus Prime Standard or Quartus Lite) supports Agilex
5.

211 Select the Individual Files to reduce the amount of space needed on a
computer. (The complete install could be downloaded, if wished but it will
use more space.)

Downloads

Installer (Recommended) Individual Files Copyleft Licensed Source

2.1.2 Select the Quartus Prime Pro Edition Part 1as

Intel® Quartus® Prime Pro Edition Part 1

D Size: 3.1 GB
ownload
QuartusProSetup-24.2.0.40-windows.exe SHAT: fd535d3b88d8eacc839c440036225ab0b49265b7

2.1.3 When the Legal Disclaimer appears, read it and select Accept as
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2.1.6

( intel' Software License Agreement

Legal Disclaimer

PLEASE NOTE: This version of software ("Software") does not contain the latest functional and security updates. In order to use this
version, you must first acknowledge the following term, which supplements and supersedes any inconsistent provision in the version of
the Intel® FPGA Software License Subscription Agreement for the product (e.g., Intel® Quartus® Prime Software, Intel® HLS
Compiler, Intel® FPGA SDK for OpenCL™, DSP Builder for Intel® FPGAs, or Advanced Link Analyzer) with which you use the
Software:

Intel does not give or enter into any condition, warranty, or other term:

i. with respect to any malfunctions or other errors in its Software caused by virus, infection, worm or similar malicious code not
developed or introduced by Intel: or

ii. to the effect that any Software will protect against all possible security threats, including intentional misconduct by third parties.
Intel is not liable for any downtime or service interruption, for any lost or stolen data or systems, or for any other damages arising
out of or relating to any such actions or intrusions or resulting from use of Software. Intel does not give or enter into any

condition, warranty, or other term with respect to interoperability.

Intel does not warrant or assume responsibility for the accuracy or completeness of any information, text, graphics, links or other items

within the Software. Please click “Accept” below to continue the download process.

Terms of Use | Privacy | Legal Information | © Intel Corporation

It should start downloading.

Select the back button in the Browser to go back to the other files

ename=QuartusProSetup-24.2.0 40-windows.exe

C @ () https//cdrdv2.intel com/v1/dl/getContent/B26844/826853 71

Softwary

Thank you. Your document should download automatically.

If the file does not start to download, please click this link

Under the Individual files of
Downloads

Installer (Recommended) Individual Files Copyleft Licensed Source

Select one by one the following files (and repeat as needed the legal
disclaimer and the back button) for the following
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Intel® Quartus® Prime Pro Edition Part 2

Size: 12.2 GB o
QuartusProSetup-part2-24.2.0.40-windows.qdz SHA1: 74fe87ec9223424e2389e665429b21f100c8a3a4

Download

Questa*-Intel® FPGA and Starter Editions

Download Size: 2.2 GB 5
QuestaSetup-24.2.0.40-windows.exe SHA1: 9d67fbaee4f76d81d550684993a16ea816858511

Intel Agilex® 5 device support (Requires Intel Agilex® common files)

Download Size: 2.8 GB
agilex5-24.2.0.40.qdz SHA1: f4ce890b1cf3805726f15¢c93f327e6c8f3ab9of2a
** Installation size: 5.88 GB
Intel® Agilex® common files
Size: 9.8 GB

Download

agilex common-24.2.0.40.qdz SHA1: 85771732b120d8c02de265f7cd9711c635cee7af

** Installation size: 10.74 GB

Ashling RiscFree IDE for Intel® FPGAs

Size: 628.1 MB
Download
RiscFreeSetup-24.2.0.40-windows.exe SHA1T: 33ba0cd62cf6207eb07b98dccab99b450be2 1aac

Intel® FPGA Power Thermal Calculator

Size: 402.2 MB
SHA1: a54a76342b31d3ec03a9cb34fbe5fealecfc9349

Download

ptc-24.2.0.40-windows.exe

The legal disclaimer will appear for the Agilex 5 devices and RiscFree IDE. The
RiscFree IDE is used for software for Nios V (soft core processor).

2.1.7 The files will now be downloaded in the computer's default download
directory (usually called downloads). The files will look like:

Name Date modified Type Size
~ Today
0 QuartusProSetup-part2-24.2.0.40-windows.qdz 7/25/2024 2:06 PM QDZ File 12,834,09...
D agilex common-24.2.0.40.qdz 7/25/2024 2:05 PM QD7 File 10,226,66...
%, RiscFreeSetup-24.2.0.40-windows 7/25/2024 1:56 PM Application 643,144 KB
D agilex5-24.2.0.40.qdz 7/25/2024 1:57 PM QDZ File 2,892,728 ...
% ptc-24.2.0.40-windows 7/25/2024 1:55 PM Application 411,839 KB
% QuartusProSetup-24.2.0.40-windows 7/25/2024 1:48 PM Application 3,258,967 ...
% QuestaSetup-24.2.0.40-windows 7/25/2024 1:55 PM Application 2,329,658 ...
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Note: Depending on the browser, there will be a circle showing the progress

of the download files, so you might have wait a while.

2.1.8 Create a new directory on your computer ie c:\Quartus_download251

2.1.9 Move all the above files to this new directory. It will be easier to have the
files in a directory to keep better track of the file such various versions of
Quartus can be installed on a computer.

This PC > Local Disk (C:) > Quartus_download242

T sort ~

View ~

Fay
Name

®, QuestaSetup-24.2.0.40-windows

] QuartusProSetup-part2-24.2.0.40-windows.qdz
] agilex_common-24.2.0.40.qdz

®% RiscFreeSetup-24.2.0.40-windows

[ agilex5-24.2.0.40.qdz

®5 ptc-24.2.0.40-windows

“%, QuartusProSetup-24.2.0.40-windows

Date modified

7/25
7/25
7/25
7/25

7/25

/2024 1:55 PM
/2024 2:06 PM
/2024 2:05 PM
/2024 1:56 PM
/2024 1:57 PM
/2024 1:55 PM
/2024 1:48 PM

2.1.10 Select QuartusProSetup-25.1.0.129-windows

Type
Application
QDZ File
QD7 File
Application
QDY File
Application

Application

Size

2,329,658 KB

12,834,091 KB

10,226,662 KB

643,144 KB

2,892,728 KB

411,839 KB

3,258,967 KB

2111 On some computers, it may be possible that you need to sign in for admin
access in order to install software. It may be a while for the Quartus to appear.
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2.1.12 Quartus window will appear as
O Installing Intel Quartus Prime Pro Edition 24.2.0.40 =

Setup - Intel Quartus Prime Pro Edition 24.2.0.40

Welcome to the Intel Quartus Prime Pro Edition 24.2.0.40 Setup Wizard.

< Back Next > Cancel

2113 Select Next

2.1.14 Read the License Agreement and select | accept the agreement as
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G Installing Intel Quartus Prime Pro Edition 24.2.0.40 — X

You can view the full license agreements on the Quartus Prime software download page or use the --install_lic option from the
command-iine to get the license agreement files before the installation. You must accept the terms of the agreement before
continuing with the installation.

QUARTUS PRIME AND INTEL FPGA IP LICENSE AGREEMENT, VERSION 24.2

Intel, Quartus and the Intel logos are trademarks of Intel Corporation
or its subsidiaries in the US and other countries. Any other
trademarks and trade names referenced here are the property of their
respective owners.

DO NOT DOWNLOAD, INSTALL, ACCESS, COPY, OR USE ANY PORTION OF THE
LICENSED SOFTWARE UNTIL YOU HAVE READ AND ACCEFTED THE TERMS AND
CONDITIONS OF THIS AGREEMENT. BY INSTALLING, COPYING, ACCESSING, OR
USING THE LICENSED SOFTWARE. YOU AGREE TO BE LEGALLY BOUND BY THE

© 1 accept the agreement

Do you accept this license?
(O 1do not accept the agreement

nstallBuilder
< Back Next > Cancel

2115 Select Next

2.1.16 Select the directory. The default directory can be left as
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(O Installing Intel Quartus Prime Pro Edition 24.2.0.40 — X
Installation directory |nte|

Specify the directory where Intel Quartus Prime Pro Edition 24.2.0.40 will be installed
Installation directory C:\intelFPGA_pro\24.2 r‘:'

< Back Next > Cancel

2.1.17 Select Next

2.1.18 Ensure that the following items are enabled (and in blue) as
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(O Installing Intel Quartus Prime Pro Edition 24.2.0.40

Select Components

— X

intel

Select the components you want to install

= @ Intel Quartus Prime Pro Edition
B8 Intel Quartus Prime Pro Edition Part 1 (14350MB)
@ Intel Quartus Prime Pro Edition Part 2 (16277.3MB)
= @ Devices
@ Intel Agilex 5 (6022.8MB)
B intel Agilex Common Files (11001.5MB)
@ Ashling RiscFree IDE for Intel FPGAs (2341.2MB)

() Questa™Intel FPGA Edition (10066.9MB)

@ Questa*-Intel FPGA Starter Edition (A zero cost license requir...

You can add additional device support to an existing
Quartus Prime software installation without having to
reinstall the entire software package. Use the Install
Devices command on the Tools menu in the Quartus Prime
software to get started.

Select a component for more information

InstallBuilder

2119 Select Next

2.1.20 The Summary window will appear as

< Back Next > Cancel
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b Installing Intel Quartus Prime Pro Edition 24.2.0.40 — X

Ready to Install intel

Summary:

Installation directory: C:\intelFPGA_pro\24.2
Required disk space: 60063 MB
Available disk space: 296132 MB

The Quartus Prime software requires that your system have sufficient physical RAM to compile designs targeting specific devices. For
detailed memory requirements for a particular device, you can check the "Memory Recommendations™ section in the "Quartus Prime
Software and Device Support Release Notes”.

https: [jwww.intel. com/content fwww jus/en rammable /documentationlit-rn.html

You can obtain a software license from the Intel FPGA Self Service Licensing Center:
https: /fwww.intel. com/content www fus/en/suppor rammable flicensing /fsupport-center.html

For more information about Intel FPGA software, go to:
https: /fwww.intel. com/content/www jus/en/products rammable.html

InstallBuilder

< Back Next > Cancel
2.1.21 It will then install as:
D Installing Intel Quartus Prime Pro Edition 24.2.0.40 — X
nstating intel
Wait while Setup installs Intel Quartus Prime Pro Edition 24.2.0.40
Instaling
Unpacking files
nstallBuilder
< Back Next > Cancel
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2.1.22 The install can take a while. (Time depends on the computer being used).

2.1.23 It will then show the following:

W Installing Intel Quartus Prime Pro Edition 24.2.0.40 —
Intel Quartus Prime Pro Edition 24.2.0.40 Installation Complete

Setup has finished installing Intel Quartus Prime Pro Edition 24.2.0.40.
@ Launch USB Blaster driver installation
@ Launch USB Blaster II driver installation

@ Install JTAG Server as a Windows service and run automatically when
Windows starts

@ Create shortcuts on Desktop
@ Launch Quartus Prime Pro Edition
(] Provide your feedback

< Back Finish

2.1.24 Select Finish

2.1.25 When the window of
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Welcome to the Device Driver
Installation Wizard!

This wizard helps you install the software drivers that some
computers devices need in order to work.

To continue, click Next.

Next > Cancel

Appears, select Next

2.1.26 Select Finish for the window of

Completing the Device Driver
Installation Wizard

The drivers were successfully installed on this computer.

You can now connect your device to this computer. if your device
came with instructions, please read them first

Driver Name Status
\/ Altera Altera USB-Blaster... Ready to use

Finish Cancel
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2.1.27 There are two device drivers so another Device Driver window will appear.
Select Next

Welcome to the Device Driver
.? Installation Wizard!

3

This wizard helps you install the software drivers that some
computers devices need in order to work.

To continue, click Next.

Next > Cancel

2.1.28 Select Finish for
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Devic

ce Driver Installation Wizard

Completing the Device Driver

i:& Installation Wizard

The drivers were successfully installed on this computer.

You can now connect your device to this computer. If your device
came with instructions, please read them first.

Driver Name Status

V/ Altera (WinUSB) JTAG c... Ready to use

Finish Cancel
2.1.29 Quartus 2025.1 will now open as
G Quartus Prime Pro Edition [=]
B0 Wik OC GG 0P VO OBAOHS =
Sroject Navigator QAHBR |y Home B 1P Catalog
a Open Example Project « Project Directory

- Library

+ @asic Functions
Bridges and Adapters
v Dsp

b Interface Protocols

o vierarchy | B Files  gi? Design Units

Tasks

Project Files
B Hew

Open.

Platform Designer
Cata

5
AL B ]
Message

~

Use Regular Expressions | Show Non-matching | AREind.. | | AfFind Hext

wessage D

2.1.30 Select File -> Exit to close Quartus.

2.1.31 The next step is download and install the Intel FPGA Power Thermal
Calculator.

There is a reason for installing this as a separate download
(even through the PTC is within Quartus). The reason is in “real life” that you

Five Years Out

Page |15

arrow.com



might want to see the approx. power of a device (to see if it would be even
suitable in terms of power) before a RTL design is even created but without
downloading and installing the entire Quartus software. The stand-alone
PTC is fast to install, requires no license file and allows you to see the
approx. power quickly. Knowing the approx. power would allow a quick
target of which device would be suitable so that Quartus work could follow.

2.1.32 Go to the Intel website of
Intel® Quartus® Prime Pro Edition Desigh Software Version 25.1 for Windows

2.1.33 Select Under Downloads -> Individual Files

Downloads

Installer (Recommended) Individual Files Copyleft Licensed Source

2.1.34 Scroll down the webpage to Power Thermal Calculator

Intel® FPGA Power Thermal Calculator

Download Size: 402.2 MB 5
ptc-24.2.0.40-windows.exe SHA1: a54a76342b31d3ec03a9cb34fbe5fea3ecfc9349

2.1.35 Double Click on the Download for the Power Thermal Calculator

Intel® FPGA Power Thermal Calculator

Download Size: 402.2 MB 5
ptc-24.2.0.40-windows.exe SHA1: a54a76342b31d3ec03a9cb34fbe5fea3ecfc9349

2.1.36 The file will download

2.1.37 After the file is downloaded (by default, it will be in the download folder of
your computer), double-click the application file as

%, ptc-24.2.0.40-windows 8/1/2024 9:09 AM Application 411,839 KB

2.1.38 The window will appear


https://www.intel.com/content/www/us/en/software-kit/826844/intel-quartus-prime-pro-edition-design-software-version-24-2-for-windows.html
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O Installing Intel FPGA Power Thermal Calculator 24.2.0.40 =
Setup - Intel FPGA Power Thermal Calculator 24.2.0.40

Welcome to the Intel FPGA Power Thermal Calculator 24.2.0.40 Setup Wizard.

< Back Next > Cancel

2.1.39 Select Next

2.1.40 Read the License Agreement, and then select the | accept the agreement
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O Installing Intel FPGA Power Thermal Calculator 24.2.0.40 — X

You can view the full license agreements on the Quartus Prime software download page. You must accept the terms of the
agreement before continuing with the installation.

QUARTUS PRIME AND INTEL FPGA IP LICENSE AGREEMENT, VERSION 24.2

Intel, Quartus and the Intel logos are trademarks of Intel Corporation
or its subsidiaries in the US and other countries. Any other
trademarks and trade names referenced here are the property of their
respective owners.

DO NOT DOWNLOAD, INSTALL, ACCESS, COPY, OR USE ANY PORTION OF THE
LICENSED SOFTWARE UNTIL YOU HAVE READ AND ACCEPTED THE TERMS AND
CONDITIONS OF THIS AGREEMENT. BY INSTALLING, COPYING, ACCESSING, OR
USING THE LICENSED SOFTWARE. YOU AGREE TO BE LEGALLY BOUND BY THE

() 1accept the agreement

Do you accept this license?
() 1do not accept the agreement

InstallBuilder
< Back Next > Cancel

2.1.41 Select Next

2.1.42 Select the Installation Directory. It can be selected as the default one as
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O Installing Intel FPGA Power Thermal Calculator 24.2.0.40 — X

Installation Directory i nte I

Specify the directory where Intel FPGA Power Thermal Calculator 24. 2.0.40 will be installed

Installation Directory |C:\intelFPGA_pro\24.2 e

InstallBuilder

< Back Next > Cancel

2.1.43 Select Next

2.1.44 The summary page will appear
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i Installing Intel FPGA Power Thermal Calculator 24.2.0.40

Ready to Install

intel

Summary:

Installation directory: C:\intelFPGA_pro\24.2
Required disk space: 556 MB
Available disk space: 233701 MB

You can obtain a software license from the Intel FPGA Self Service Licensing Center:

https: //www.intel. com/contentwww fus/en/su rammable licensing/sui t-center.html

For more information about Intel FPGA software, go to:
https: /fwww.intel.com/contentwww fus/en/products rammable.html

InstallBuilder

2.1.45 Select Next

2.1.46 It will then install as

Next >

Cancel
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O Installing Intel FPGA Power Thermal Calculator 24.2.0.40 — X

Instaling intel

Wait while Setup installs Intel FPGA Power Thermal Calculator 24.2.0.40
Installing
Unpacking files

nstallBuilder

< Back Next = Cancel

2.1.47 Once itis complete, it will show the window as
& Installing Intel FPGA Power Thermal Calculator 24.2.0.40 — X

Intel FPGA Power Thermal Calculator 24.2.0.40 Installation Complete

Setup has finished installing Intel FPGA Power Thermal Calculator 24,2.0.40,

< Back Finish Cancel

2.1.48 Select Finish
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3. Licensing

The Quartus software (when targeting Agilex 5) needs a free license. The Questa-
Sim Intel FPGA Starter and NIOS-V /m 32-bit RISC-V soft processor also needs a free
license.

To license the Quartus and Questa-Sim Intel, which is free license software, go to

Intel® FPGA Licensing Support Center and select License Generation for
Self Service Licensing Center. You will need to login and program your
NIC # to get a license file.

Step 2: License Generation

Generate a license file from
the Intel® FPGA Self-Service

Get Started FAQs Quick Links NIC/Host/Guard ID

Get Started

Thank you for choosing Intel® as your technology partner. We are here to guide you through the licensing process and help you make the most of your FPGA experience. Whether you are new or an existing user, this page
will provide you with all the essential information to get started quickly.

Step 1: License Key Required? Step 2: License Generation Step 3: License Setup Step 4: Debugging
Check the software tool license requirement. Generate a license file from the Intel” FPGA Self- Set up the license depending on the type of license  Troubleshoot and debug any licensing issues.
Service Licensing Center. used.

If already enrolled in the Intel® FPGA Self-Service Licensing Center:

Sign In

Already enrolled ? - Sign In here

If you are not enrolled in:


https://www.intel.com/content/www/us/en/support/programmable/licensing/support-center.html
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Enroll

If you don't already have access to the Intel® FPGA Self Service Licensing Center
(SSLC), enroll to get an account.

Enroll for Intel® FPGA Self Service Licensing
Center (SSLC)

Sign up for Evaluation or No-Cost Licenses:

Intel® FPGA Self-Service Licensing Center

Home Licenses v  Computers and License Files v Admins v  Sign up for Evaluation or No-Cost Licenses  Reports  Help v

: o : s 0 e
Hi! Welcome to the

new Licensing Center.

Try the new License Assistant

f v i
intel o

Create the following licenses, repeat the same steps for the creation of each license.

Agilex™ 5 E-Series FPGA Software
@ _ 2025-09-23
Enablement (License: SW-AGILEX-5E)

[:] Questa*-Intel® FPGA Starter Edition (License: SW-QUESTA) 2025-09-23
O Nios® V/m Microcontroller Intel® FPGA IP (License: IP-NIOSVM) 2025-09-23
A license file will be sent to your registered e-mail address for each license.

Save the attached license file to the computer where you will use the license. It is
recommended to save the file with the extension.dat.

Do not use double-byte characters or spaces when renaming the file and when
saving in the folder path

Perform the following steps to install the licenses:
1. Save the license.dat file. The preferred location is:
o Windows* :<drive>:\flexlm

o Linux: /usr/local/flextm/licenses
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2. Set the OS environment variables. In Windows:

a. Open the System Properties window by pressing the Windows key and “R”.
This will open the Run window. Type the following Run command:

SystemPropertiesAdvanced
Then hit enter.

Next click the Environment Variables button near the bottom.
c. Goto New to make to set the tree variables, for example

Variable name LM_LICENSE_FILE

variable value Questa-Sim Intel FPGA Starter location in drive

To specify more than one license location with the LM_LICENSE_FILE
environment variable, modify the existing LM_LICENSE_FILE environment
variable and separate the different paths with semicolons (;), as shown in the
following example:

Mueva variable del sistema 4
Nombre de la LM_LICENSE_FILE

Valor de la CAflexlm\LR-190528_License.dat;LR-190529_License.dat,LR-190530_License.dat
Examinar directorio... Examinar archivo... Aceptar Cancelar

3. Open Quartus software. Go to Tools -> License Setup and select
LM_LICENSE_FILE variable.
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{:} Options X

Category:
- General License Setup
| Fonts

E Headers and Footers Settings License file: D528_License.datLR-190529_License.dat;LR-190530_License.dat;| ...

Internet Connectivit
@ Y v Use LM_LICENSE_FILE variable: -190529_License.datLR-190530_License.dat;

I Libraries
~ & Board and IP Settings Current license
.._-l IP and Development Board Search Sett Download License
n’ Design Examples Search Locations Mode: quartus_agilex5e : i
:Ef.'i EDA Tool Options Begin 30-day Grace Period
E‘x License Setup Expiration: 23-sep-2025 wait for floating licenses
I Preferred Text Editor
% Processing HostID Type: NICID Get no-cost licenses
& Tooltip Settings
s Colors Host ID Value: 0456e5268b03 V| Automatically Refresh License Server
- ‘g Messages
“# Colors Licensed AMPP/IP cores functions:

4. USB Programmer

Before programming the Arrow AXE-5 Eagle board, the USB Programmer needs to
be installed.

4.1.The USB Programmer is needed for Arrow USB Programmer that is on the AXE-
5 dev board can be found at the Trenz website
Download | Trenz Electronic GmbH Online Shop (DE) (trenz-electronic.de)
And selecting the following (The website can be translated to English)

Online Documentation:
« Trenz Electronic Wiki Documentation » » Arrow USB Programmer

NOte-s.Sollten Sie die von Thnen bendtigten Dokumente nicht gefunden haben, wenden Sie sich bitte an den Trenz Electronic Support (support[at]trenz-electronic.de).
Arrow_USBE_Programmer_2.0 - Arrow USB Programmer 2.0 Libraries
Arrow_USBE_Programmer_2.1 - Arrow USB Programmer 2.1 Libraries
Arrow_USB_Programmer_2.2 - Arrow USB Programmer 2.2 Libraries
Arrow_USB_Programmer_2.3 - Arrow USB Programmer 2.3 Libraries
Arrow_USB_Programmer_2.4 - Arrow USB Programmer 2.4 Libraries
Arrow_USB_Programmer_2.5 - Arrow USB Programmer 2.5 Libraries <—
Dateien [-] Alle zuklappen
+ Documents (1 Dateien)

/= Arrow_USB_Programmer2-Troubleshooting_Guide_for_WinOS.pdf
GroBe 350,35 KB / Geéndert 07.03.2018 - 13:59:19 é

+ Diagnose Programm fiir Win OS (1 Dateien)

&

Arrow_USB_Programmer2-Diagnostic_Program_for_Win_0S.zip
GroBe 218,36 KB / Gedndert 15.04.2020 - 16:32:58

+ Andere Dateien (0 Dateien)

4.2 Verify the installation was successful.

Plug the USB cable into the micro USB connector of the Arrow Blaster module. Plug
the other end of the cable into the USB type A connector of the PC.

Five Years Out Page I 25 arrow.com


https://shop.trenz-electronic.de/Download/?path=Trenz_Electronic/Software/Drivers/Arrow_USB_Programmer

Open the Device Manager.

If the following appears, then it is successful.

w i LIniversal 5erial Bus contrallers

i USE Serial Converter A
i LI5E Serial Converter B

However, if there are two entries under Other Devices then an additional driver

installation is required.

Click on the following link to install the FTDI D2XX Direct Drivers for Windows.

5. Environment Variables

5.1 Add an environment variable for the Nios processor tools as shown in the figure

below.

System Properties
Computer Name Hardware Advanced System Protection  Remote

You must be logged on as an Administrator to make most of these changes.

Performance
Visual effects, processor scheduling, memory usage, and vitual memany

Settings...
User Profiles
Desktop settings related to your sign-n

Settings...
Startup and Recovery
System startup, system failure, and debugging information

Settings

Enviropment Variables ..

oK Cancel Apply

Environment Variables
User variables for 202473
Variable Value
Path C\Users\aD8473\AppDatat Local\Microsoft\WindowsApps; ChlUsers...
QSY5_ROOQTDIR D:\intelFPGA_prot\24.2\qsys\bin

QUARTUS_ROOTDIR
OUARTLIS ROCTDIR_QVERRI

DilintelFPGA_prot24.1\quartus
[hlintelEPGA_litet 15,1

L SOPC_KIT_NIQS2

1 |

TEMP
TMP

C\Users\a02473\AppDataiLocal\ Temp
C\Usersh 302473 ApoDatat Local\ Temp

Systerm variables

Mew... Edit... Delete

Variable
__PSLockDownPolicy
chassis

Combpec

DriverData
LATTICE_INI_PATH
model

6. Remote Software and install

Value

1]

Motebook
CAWINDOWS\system32\emd.exe
CAWindows\System32\Drivers\DriverData
Ci\lsc_env

7550

6.1 If you are using the CloudLabs Virtual Machines, the Quartus software and lab

source material will be pre-installed and licensed.


https://ftdichip.com/wp-content/uploads/2021/08/CDM212364_Setup.zip
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7. VirtualBox Virtual Machine Installation (Linux lab only)

The Linux lab needs a Linux host to create a Linux bootable system for the AXE5-Eagle board.
Download the Oracle VirtualBox Manager. Then download and unzip the Ubuntu 22.04 LTs VM
image. You need approximately 40GB of free disk space to download and extract the VM.

7.1 Download and install the VirtualBox manager for Windows.

7.2 Navigate to the Workshops page. Click on Download the Ubuntu 22.04 LTs
Virtual Machine. This will take a while depending on your internet connection (18 GB
file size).

7.3 Extract the Virtual Machine by right clicking on Ubuntu_2204_LTS_xxxx.zip. This
can take approximately 10 minutes depending on the performance of your laptop.

7.4 Open the VirtualBox Manager. Select Machine - Add. Navigate to the Agilex 5
Workshop VirtualBox Machine Definition file and select open.

7.5 Use the Settings option to make changes to the System based on your laptop.
Click on System and then the Motherboard tab to adjust Base Memory. Click on The
Processor tab to adjust the number of processors.

7.6 The password for the VirtualBox VM is root. This must be used when executing
super user sudo commands.

7.7 Download and install Tera Term terminal emulator.
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https://download.virtualbox.org/virtualbox/7.1.0/VirtualBox-7.1.0-164728-Win.exe
https://github.com/ArrowElectronics/Agilex-5/wiki/AXE5-Eagle-Workshops-25.1
https://github.com/TeraTermProject/teraterm/releases/download/v5.3/teraterm-5.3.exe

8. Legal Disclaimer

ARROW ELECTRONICS

EVALUATION BOARD LICENSE AGREEMENT

By using this evaluation board or kit (together with all related software, firmware, components,
and documentation provided by Arrow, “Evaluation Board"”), You (“You”) are agreeing to be bound
by the terms and conditions of this Evaluation Board License Agreement (“Agreement”). Do not
use the Evaluation Board until You have read and agreed to this Agreement. Your use of the
Evaluation Board constitutes Your acceptance of this Agreement.

PURPOSE

The purpose of this evaluation board is solely intended for evaluation purposes. Any use of the
Board beyond these purposes is on your own risk. Furthermore, according the applicable law, the
offering Arrow entity explicitly does not warrant, guarantee or provide any remedies to you with
regard to the board.

LICENSE

Arrow grants You a non-exclusive, limited right to use the enclosed Evaluation Board offering
limited features only for Your evaluation and testing purposes in a research and development
setting. Usage in a live environment is prohibited. The Evaluation Board shall not be, in any case,
directly or indirectly assembled as a part in any production of Yours as it is solely developed to
serve evaluation purposes and has no direct function and is not a finished product.

EVALUATION BOARD STATUS

The Evaluation Board offers limited features allowing You only to evaluate and test purposes.
The Evaluation Board is not intended for consumer or household use. You are not authorized to
use the Evaluation Board in any production system, and it may not be offered for sale or lease, or
sold, leased or otherwise distributed for commercial purposes.

OWNERSHIP AND COPYRIGHT

Title to the Evaluation Board remains with Arrow and/or its licensors. This Agreement does not
involve any transfer of intellectual property rights (“IPR) for evaluation board. You may not
remove any copyright or other proprietary rights notices without prior written authorization from
Arrow or it licensors.

RESTRICTIONS AND WARNINGS

Before You handle or use the Evaluation Board, You shall comply with all such warnings and other
instructions and employ reasonable safety precautions in using the Evaluation Board. Failure to
do so may result in death, personal injury, or property damage.

You shall not use the Evaluation Board in any safety critical or functional safety testing, including
but not limited to testing of life supporting, military or nuclear applications. Arrow expressly
disclaims any responsibility for such usage which shall be made at Your sole risk.

WARRANTY

Arrow warrants that it has the right to provide the evaluation board to you. This warranty is
provided by Arrow in lieu of all other warranties, written or oral, statutory, express or implied,
including any warranty as to merchantability, non-infringement, fitness for any particular
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purpose, or uninterrupted or error-free operation, all of which are expressly disclaimed. The
evaluation board is provided “as is” without any other rights or warranties, directly or indirectly.

You warrant to Arrow that the evaluation board is used only by electronics experts who
understand the dangers of handling and using such items, you assume all responsibility and
liability for any improper or unsafe handling or use of the evaluation board by you, your
employees, affiliates, contractors, and designees.

LIMITATION OF LIABILITIES

In no event shall Arrow be liable to you, whether in contract, tort (including negligence), strict
liability, or any other legal theory, for any direct, indirect, special, consequential, incidental,
punitive, or exemplary damages with respect to any matters relating to this agreement. In no
event shall arrow’s liability arising out of this agreement in the aggregate exceed the amount paid
by you under this agreement for the purchase of the evaluation board.

IDENTIFICATION

You shall, at Your expense, defend Arrow and its Affiliates and Licensors against a claim or action
brought by a third party for infringement or misappropriation of any patent, copyright, trade
secret or other intellectual property right of a third party to the extent resulting from (1) Your
combination of the Evaluation Board with any other component, system, software, or firmware,
(2) Your modification of the Evaluation Board, or (3) Your use of the Evaluation Board in a manner
not permitted under this Agreement. You shall indemnify Arrow and its Affiliates and Licensors
against and pay any resulting costs and damages finally awarded against Arrow and its Affiliates
and Licensors or agreed to in any settlement, provided that You have sole control of the defense
and settlement of the claim or action, and Arrow cooperates in the defense and furnishes all
related evidence under its control at Your expense. Arrow will be entitled to participate in the
defense of such claim or action and to employ counsel at its own expense.

RECYCLING

The Evaluation Board is not to be disposed as an urban waste. At the end of its life cycle,
differentiated waste collection must be followed, as stated in the directive 2002/96/EC. In all
the countries belonging to the European Union (EU Dir. 2002/96/EC) and those following
differentiated recycling, the Evaluation Board is subject to differentiated recycling at the end of
its life cycle, therefore: It is forbidden to dispose the Evaluation Board as an undifferentiated
waste or with other domestic wastes. Consult the local authorities for more information on the
proper disposal channels. An incorrect Evaluation Board disposal may cause damage to the
environment and is punishable by the law.
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